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Proprietary Rights of Business Technology, Inc. (BTi) applications include the 

following: 

The Attendant Solutions suite of products and related data and information are 

proprietary and confidential to BTi and are the subject of trade secrets and 

copyrights licensed from BTi. The programs and related data and information are 

provided in confidence. All use, disclosure, copying, transfer or storage of these 

items, except as authorized in the written License Agreement from BTi to the user, is 

strictly prohibited. Information in this document is subject to change without notice 

and does not represent a commitment on the part of BTi. 

COPYRIGHTS: 

© 2022 Business Technology, Inc. (BTi).  All Rights Reserved. 

301 Mallory Station Rd., Suite 200, Franklin, TN 37067; United States of America. 

TRADEMARKS: 

BTi and the Attendant Solutions and individual application logos are registered 

trademarks in the United States of America. 

All other brand or product names mentioned may be trademarks of their respective 

companies or organizations. 
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Preface 

Welcome to the News Update Attendant™ 7.0 User Guide. This guide describes the 

features of the News Update Attendant™ application. 

Intended Audience 

This guide has been written for System Administrators, News Directors, Lead News 

Producers, News Producers, and Master Control Operators to help in learning the 

functionality available in News Update Attendant. 

BTi Technical Support 

Technical support is available to answer questions and to help with any problems 

encountered using the Attendant Solutions suite of products. BTi Technical Support 

may be contacted in several ways: 

Method of Contact Information 

Website www.bti.tv 

Email support@bti.tv  

Voice U.S. 615 591 1900 x1 

We Value Your Input 

We are interested in hearing your comments about this book, particularly if it fell 

short of your needs or expectations.  Please send your comments to 

support@bti.tv. 

 

http://www.bti.tv/
mailto:support@bti.tv
mailto:support@bti.tv
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1      
Introduction 

News Update Attendant lets broadcasters tap into virtually any news and 

information data source and instantly deliver that content on air, online or to 

mobile devices as part of complete, formatted graphics. The News Update 

Attendant server continuously monitors, captures, and retrieves user specified 

news, weather, financial, and sports data from preferred wire services and web 

servers; then uses that content to populate graphic templates for fully automated 

on-air playback. 

Designed for maximum flexibility, News Update Attendant allows users to select 

data sources as needed, even while on-air, to support changing news, branding, 

and promotional requirements. News Update Attendant lets the user add, delete, 

sort or re-sequence content anytime, even while on air. Now it is easy to insert local 

and breaking news at the head of a news ticker. 

Select from a huge range of wire services including: AP (Television News Headlines, 

News Minutes, News Alerts, and Sports Data), BTi Sports Data Feed, WSI (weather), 

AccuWeather, Ticker Technologies (financial markets, stock data), DataBridge, and 

web sites. 

News Update Attendant is also a powerful revenue generator, enabling 

broadcasters to easily link sponsors to relevant presentation elements. News 

Update Attendant makes it easy to rotate sponsorships and data from other 

Attendant Solutions automatically based on user defined criteria. 

 

About This Book 

BTi developed this user guide to describe the features of the News Update 

Attendant . It consists of the following sections: 

Section Description 

2 – Accessing News Update 

Attendant 

Describes how to start Attendant 

Solutions and access the News Update 

Attendant 

3 – Configuring News Update 

Attendant 

Describes the NUA Options screen 

which enables the user to customize 

how News Update Attendant works  
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Section Description 

4 – Creating News Types Describes how to create additional news 

types (topics) using the Setup News 

Types screen 

5 – Creating and Maintaining News 

Items 

Describes how to add, edit, and delete 

news items, as well as edit the 

parameters of existing news items using 

the Enter News Items screen 

6 – Transmitting News  Describes how to view active news 

alerts, create new news alerts, activate 

news alerts, and edit existing news alerts 

using the Transmission Status screen 
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2 
Accessing News Update Attendant™ 

To start Attendant Solutions and access the News Update Attendant application, 

double click the Attendant Solutions icon found on the computer desktop to open 

the Login screen. 

Enter your User ID and password and then click [Login].  

Note: Contact your system administrator if you do not have an assigned User ID 

or password. 

 

The Main Menu screen displays. 

 

 
 

Note: The applications displayed on the lower right of the screen will vary 

depending upon which applications have been purchased. 

Click the [News Update] button to open the application.  

The menu bar at the top will change to show News Update in the drop-down list 

and will display buttons associated with the News Update Attendant application. 
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3 
Configuring News Update Attendant™ 

This section describes the News Update Options screen which enables the user to 

customize how News Update Attendant works.  

 

To access the News Update Options screen, select File > NU Options on the Main 

Menu screen. 
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The News Update Options screen displays with the 'Reset' tab open. 

 

 

'Reset' Tab 

The 'Reset' tab is used to clear data and user fields in News Types and to delete 

news items. 

To reset News Type data fields, select the News Type to be purged by clicking the 

check box beside it.   

Click [Clear Data Fields] or if preferred, [Clear Data + User Fields]. 

When the dialog box displays asking to confirm, click [Yes]. 
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To delete expired news items, select the News Type by clicking its check box and 

then click [Delete Expired Items]. A confirmation screen will be displayed. 

(Note that the expiration date and time of a news item is established when setting 

up or editing a News Type, covered in Chapter 4.) 

 

When [Delete All News Items] is chosen, the marked News Type will be cleared of 

all news items regardless of age. A warning and confirmation will be displayed. 

 

If [Delete Items by Age] is chosen, the current date and time will display near the 

bottom of the window. This time may be changed by clicking the ellipsis [...] beside 

the date. 

 

 

 

After the date and time have been chosen, click [Proceed].  

When the dialog box appears asking for confirmation, click [Yes]. 
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'Notify' Tab 

The 'Notify' tab is used to enable warnings to be sent if no news items have been 

received. Selected news types will fire email notifications when no data has been 

received for a period of time. This is especially useful for monitoring wire captures 

to ensure data is being received. 

 

 

 

The notification at the top of the list is fired first.  

To prioritize notifications, click the notification to be moved and then click the [Up] 

or [Down] button.  

To enable notifications, click [Edit]. 

A check mark indicates whether a notification is enabled. Click the Enabled cell to 

turn on or turn off the check mark for that notification.  

Click [Save] to save any changes and exit the Edit mode. 

Note: Notifications are more extensively edited and created using the 'Notify' tab 

located on the Main Menu under File > Configure Attendant. Please refer to the 

Attendant Solutions User Guide for more details. 
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'List' Tab 

The 'List' tab is used when creating lists.  

 

 

 

These lists are used in the elements of a News Type and serve as a way of limiting 

entry choices to only those on the list. 
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'Database' Tab 

The 'Database' tab displays workstation information and current SQL information 

on the number of News Types and items that exist on the database. 
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4 
Creating and Maintaining News Types 

This section describes how to create and edit News Types (topics) using the Setup 

News Types screen. This screen is used to:  

 Create News Types based on existing News Types 

 Edit News Type elements  

 Choose and sequence which elements will display on air  

 Assign access rights to a News Type  

 Decide the order of a transmission  

 Set up standard values for a News Type 

 

To access the Setup News Types screen, start at the Main Menu and click [Setup] or 

select Edit > Setup News Types. 
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The Setup News Types screen displays. 

 

 

 

Creating News Types 

News Types (topics) are created by copying an existing News Type and modifying it 

as needed or by defining a new News Type.  

The second method is not intended for the end user but is used by BTi's 

programmers.  

To create a News Type based on an existing type, select a News Type from the list 

on the left which is similar to the desired News Type. 

 

Click [Copy].  A message displays confirming the copy of a News Type.  

Click [Yes] to confirm. 
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Enter a unique code for the News Type (no more than 6 characters) and click [OK]. 

 

 

 

Enter a News Type description and then click OK. 

 

 

 

The new News Type appears in the News Types list arranged alphabetically by 

code.  

 

To enable editing, make sure that the “Allow Edits” check box at the upper right of 

the Setup News Types screen is checked, as shown below.  
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To delete a News Type, select the News Type to delete and then click [Delete].  

A message displays asking to confirm.  

Click [Yes] to delete. 

 

 

 

 

Editing News Types 

The Setup News Types screen is also used to edit News Types.  

To edit a News Type, select the News Type to be edited. The News Type detail 

displays in the right panel of the screen, grouped into five sections. 

'General' Tab 

The 'General' tab is used to add or remove elements to be displayed in the Enter 

News Items screen, as well as to set timing options for the News Type.  

 



News Update Attendant User Guide 7.3 

 

Business Technology, Inc. Rev Apr, 2022 19  

  

 

• To add elements to be displayed, choose the element from the Elements 

list on the left and then click [>>] to move the element to the Display 

Elements list on the right. An element may also be moved by simply double 

clicking the element. 

• To move a display element back to the Elements list, select the element to 

move from the list on the right and then click [<<] or just double click the 

element. 

• When creating or editing a News Type, a value is defined for the active life. 

When a News Type is given an active life span, News Update Attendant 

inactivates it after the amount of time specified. If this field is left blank or a 

zero is entered, the News Type remains available and active until it is 

removed manually, either by removing the check mark from the “OK to 

show this item?” check box on the edit screen of that News Type or by 

deleting it from the headline list.  

Note: News coming from a data source may or may not have an active life. If 

the news items are constantly overwritten, it is not necessary to have an 

active life assigned. If the news items are not constantly overwritten (such as 

sports scores), it is necessary to assign an active life value to prevent the 

airing of scores from previous dates. 

• Enabling the “Show Life & Start Time during Entry” check box displays the 

life span of the News Type on the News Update Entry screen. It also allows 

for entering News Types before they go into the transmission and for 

assigning a time to start running the transmission. 



News Update Attendant User Guide 7.3 

 

Business Technology, Inc. Rev Apr, 2022 20  

• A value may be entered in the "# Days History to be maintained" field. The 

data is preserved for the specified amount of time. If a zero is entered, the 

data is kept indefinitely until manually removed. 

• “Default Air Time in Ticker….” allows entering the number of seconds the 

News Type will display (if not determined by the transmission.) 

• “Default new Items to Hold…” will require new items to always be released 

manually before going to air. 

• Click [Save] to save any changes. 

 

'Users' Tab 

The 'Users' tab is used to assign access rights to a News Type.  

Accessible by "--ALL--" is the default assignment. 

 

 

 

• To allow access by a user profile, select the profile(s) from the list on the 

left and click [>>] or double click to move the profile to the list on the 

right. 

• To restrict access, select the user profile(s) to be removed from the list on 

the right and click [<<] or double click to move the profile to the Profiles 

list on the left. If no profiles are in the list on the right, access to --ALL-- will 

be granted. 

• Click [Save] to save any changes. 
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'Sorting' Tab 

The 'Sorting' tab is used to define the order of the news items in the transmission 

for the specified News Type.  

News items are transmitted in the order shown in the Transmit-Order list shown on 

the right side of the screen. 

 

 

 

• To set the order of items in the transmission, select the items from the list 

on the left in the order to be transmitted and click [>>] or double click the 

item to move it to the Transmit-Order list on the right. The item will be 

added to the bottom of the list. 

• To remove an item from the Transmit-Order list on the right, double click 

the item to be removed or select it and click [<<]. 

• To rearrange the transmit order, the items must first be removed from the 

transmit list and then re-added in the desired order. 

• Click [Save] to save any changes. 

 
'Parameters' Tab 

The 'Parameters' tab permits users to set up standard values for the specified news 

type. 
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Options are given under the grid to choose how parameter changes will be applied.  

 

'Elements' Tab 

The 'Elements' tab is used to edit news type elements to be displayed on air.  
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Some news types have several elements. For example, a weather news type may 

have city name, temperature, wind chill, humidity, and current conditions. 

Select an element to display the detail in the lower half of the Elements tab.  

• Edit the Element Description as needed. The Element Description is the label 

displayed next to the element when entering or editing news items. These 

descriptions are also the names of the column headings in the table on the 

right side of the Enter News Items screen (shown in the next chapter).  

• Click the “Required” check box if this item must have an element before the 

entry goes into a transmission.  

• The element type can be Numeric, Text, Date, Time, or List. The type is preset 

(not editable) and is determined when the element is created.  

• Depending upon the type of element chosen, the following fields further define 

the element type: 

 Length – Maximum number of characters that can be entered for a text 

element based upon the transmission. For a ticker, the length of the item is 

not critical. However, if the text is going into a reveal, only a certain amount 

of information can be displayed at one time.  

 Text Case – The type of text case the text element contains. Choices 

include: None, Sentence Case, Word Case, Upper Case, and Lower Case. 

 Range – If the element type is Numeric, these are the minimum and 

maximum values that can be entered. Range is displayed only for a 

Numeric element type. 

 Decimals – The number of decimal places that can be entered for a 

Numeric element. 

 List Names - If the element is a List type, this field designates which list is 

used to limit the entry choices in the field. For instance, if the list is High 

School Sports teams, then only the teams in the list may be chosen. 

• Click [Save] to save any changes. 
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5 
Creating and Maintaining News Items 

The Enter News Items screen is used to add, edit, and delete news items, as well as 

to edit the parameters of existing news items. 

To access the Enter News Items screen, start from the Main Menu and click [Entry] 

or select Edit > Enter News Items. 
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The Enter News Items screen displays. 

 

 

 

The News Types are listed in the left panel. News items for the specified news type 

display in the right panel. 

Click the “Active Items only” check box at the upper right to view only active news 

items. 

Active items may be further filtered by clicking the "Txmit Items only" checkbox. 

Note the instructions at the lower left of the screen. The [More Help] button 

displays a more complete set of instructions. 

Adding News Items 

To add news items, begin at the Enter News Items screen and select a news type 

from the News Types list in the left panel. 

Click [New Item].  
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The Item screen displays in New mode showing the particular news item 

parameters for the news type chosen. Different parameters will be displayed 

depending upon the requirements of the news type. For example, the parameters 

for a weather news type would not pertain to a sports news type. 

 

 

 

Enter values for the news item parameters. 

Note: All fields with an asterisk (*) are required for the item to be included in a 

transmission. 

 

Generic Parameter Description 

Sequence Code Items can be sorted within a news type by assigning an 

alpha/numeric code to each.  For example, enter 

Sequence Codes A1, A2, A3, …, A9 to the first group of 

items within a type and B1, B2, B3, …, B9 to the next 

group of items within the same type, etc 

Headline Text to be aired 

Keep Active for Displays the lifetime for this particular item in hours or 

minutes based on the active life value. This value may be 

edited if the item needs to be aired for a different period 

of time. 

Start Time Sets an item to be aired immediately or after a specific 

time 
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Allow Automatic 

Updates 

Enables automatic updating, otherwise updates are 

manual 

Include in Transmission Enables news item to be aired 

 

Click [Save] after values have been entered. 

Editing News Items 

A news item is edited within a News Type by selecting it from the right side of the 

Enter News Items screen and double clicking the cell to be edited. 

 

 

 

The selected cell will change color and allow the text in the cell to be edited.  

 

When the text has been edited, save the item by clicking [Exit Edit Mode] at the 

upper right of the screen or by clicking [Exit] at the bottom right.  



News Update Attendant User Guide 7.3 

 

Business Technology, Inc. Rev Apr, 2022 28  

Creating News Items Based on Existing News Items 

News items may be created based on existing news items by using the [Copy] 

button. 

To do this, begin at the Enter News Items screen and select a news type from the 

News Types list in the left panel. 

Select the news item to be copied in the Items list in the right panel and click [Edit 

Item]. 

The News Item displays in Edit mode.  

 

 

 

Click the [Copy] button.  

When the confirmation displays, click [Yes]. 

 

 

 

 



News Update Attendant User Guide 7.3 

 

Business Technology, Inc. Rev Apr, 2022 29  

The News Item displays in Copy mode. 

 

 

 

After entering and/or changing values for the news item parameters, click [Save]. 

 

Deleting News Items 

To delete news items, begin at the Enter News Items screen and select a news type 

from the News Types list in the left panel. 

Click [Delete...] 
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The screen will display in Delete mode. 

 

 

Select the item(s) to be deleted individually or by choosing a selection method on 

the left. 

 

Then click [Delete Selected Items]. 

 

When asked to confirm, click [Yes]. 
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6 
Transmitting News 

News is transmitted by accessing the Transmission Status screen, which is used to: 

 Start, pause, and stop transmissions  

 View the status of transmissions  

 Create new transmissions based on existing transmissions 

 Edit and delete existing transmissions 

To access the Transmission Status screen, start from the Main Menu and click 

[Transmit] or select File>Transmit Alerts. 

 

 

  



News Update Attendant User Guide 7.3 

 

Business Technology, Inc. Rev Apr, 2022 32  

The Transmission Status screen displays. 

 

 

 

The display shows a list of transmission jobs in the main part of the screen, 

according to the selections made on the left hand side. 

 

Note: In this application, the terms "job" and "transmission" are synonymous.  

 

Devices List 

The list of Devices at the top left of the screen shows devices for which jobs are 

available, as well as the status of the device and the port on which it is connected. 

Select a specific device to limit the job list display to that device only.  

 

Applications List 

The list of Applications on the left side of the screen shows applications that have 

been installed on the server. Select a specific application to limit the display to that 

application. 

In the following example, 'News Update' was chosen in the Applications list, which 

limits the job list to show only those jobs which pertain to News Update. 
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At the right of the Applications list are three additional buttons: 

[Show Active Jobs 

Only] 

Limits the display to active jobs. 

[Show Spots with Data 

Connectors] 

This option is not currently used.  

[Show Hidden (*) 

Jobs] 

Shows jobs that have been marked as hidden. This 

option is only available to administrators. 

Groups List 

In the lower left section of the screen, custom Groups can be set up that contain a 

specific list of jobs for a particular user function. A group might be set up for each 

shift, for example. Groups may also be used to limit access to certain jobs. These 

groups can be managed with the [New], [Edit], and [Delete] buttons.  

Jobs List 

The main part of the screen consists of the Jobs list, which shows information about 

all the jobs which are currently available, their job ID, the devices associated with 

them, and their status. 

There are four columns which describe each job: 

Job ID A unique number generated by the application which 

represents a specific transmission or job that has been saved 
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Job Name Name of the transmission job as created or edited by the 

user. The job name usually indicates or describes the type of 

transmission job. For example, “EAS Alert Crawl for WBTI”. 

Device The graphic device which will generate the output for the 

job. A job can only use one device.  

Status Indicates status of the transmission, either Active, Paused, or 

idle. A job's status will show as n/a (not available) if its 

associated device is not running. 

With the appropriate user permissions, these jobs can be edited and copied.  Jobs 

which have been previously duplicated from an original can also be deleted if the 

user has permissions, but original jobs cannot be deleted.  

Associated with each job in the list are buttons labeled as follows: 

  [Configure],   [Content],   [Start],  and  [Take]. 

 

 

 

Configuring a Job 

When the [Configure] button is clicked for a particular job, its Configure Job screen 

will display: 

 

 

From this screen, job details can be changed or edited, conditions can be set for the 

automatic termination of the job, the job can be hidden, and the job can be copied 

or deleted. 
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• A job must be assigned to a specific device (PC, server, or CG) on which the 

transmission is activated. Choose a device from the "Assigned to Device" drop 

down list. 

• End Job group box --   

-- If needed, enter the time to stop this transmission or the number of cycles 

for this job to run. If these fields are left blank, the transmission runs continually 

until it is manually interrupted.  

-- When a job ends normally, it can link to another job. If this is to happen, 

choose a transmission job to be activated when this one ends.  

• Optionally, enter a priority value between 1 and 99, where 1 is the lowest 

priority and 99 is the highest priority. This value is used to prioritize jobs. The 

highest priority is often used for the most severe weather alerts. If the priority 

value is blank or set to zero, the job is not included in processing of priorities. 

When a priority is assigned, the number will show within brackets following the 

name in the jobs list.  

A note about priorities:  

When a job with a priority is started, it executes in the same manner as 

normal, but it also registers itself to the system. It is not until a second job 

with a priority starts that any changes are apparent. 

For example, if Job 1's priority is higher – Job 2 recognizes it should not be 

running and terminates itself. If both jobs have the same priority – Job 2 

terminates. If Job 2's priority is higher – Job 2 instructs Job 1 to terminate and 

then Job 2 continues.  When Job 2 is complete, it has the option to "Restart" 

the job it terminated, namely Job 1. This happens if the Job 2 "Restart" check 

box is set. 

News Update  Attendant is capable of handling multiple job streams of 

priorities, as the case would be if the system is driving two character 

generators simultaneously.  Jobs with priorities for one CG, should not affect 

a job with a priority on another CG. By default, the name of the CG is used 

to control job streams, but other options are available if needed. 

• The job may be hidden from display all the time or hidden only when active. 

These options are often used for a job which should never be stopped. 

• Job details can be locked to prevent other users from making changes. 

• The job can be copied by using the [Copy Job] button. This would be useful if a 

job is needed to run on second device or at another time. To create a new job, 

an existing job with a similar function must be copied and modified to the 

user's requirements. See the section below for the procedure on creating a new 

job based upon an existing job. 

• To delete a job, click the [Delete Job] button. When asked to confirm, click 

[Yes].  

Editing A Job  

By using the [Configure] button, a job's attributes can be edited as described above, 

such as the job name, its assigned device, etc.  
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The [Content] button is used to further edit a job which was recently created or to 

edit the content of any other transmission job. Clicking the [Content] button for a  

job displays the Maintain Transmissions screen for that job: 

 

In this example, the Opening Message and Closing Message may be added or 

edited. 

 

Some transmissions have customizable fields that can be accessed by clicking the 

[Customize] button. When clicked, the Advanced Transmission Parameters screen 

displays, where more edits can be made. 

 

 
 

The Parameters in this screen will vary depending on the type of transmission.  

Modify the transmission parameters if necessary and click [Close]. 
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Starting / Stopping a Job 

On the Transmission Status screen, a job is started by clicking the [Start] button to 

the right of the job. 

 

 

When the job is started, the status shows as Active and the button icons change to 

show new functions - Stop and Pause. 

 

 

If the transmission is paused, the transmission is taken off air, the Status changes 

and the [Take] button will change to allow resuming the transmission. 

 

 

When a job is started, the job's Status screen is displayed: 
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Note: This screen only appears on the device to which the job is assigned. Also, it 

may not be visible due to being hidden behind other open screens. 

 

The Status window displays the following transmission information: 

Job Name Name of the job. It is displayed in red 

Started at: Transmission start date and time 

Cycle # The number of times the data has been passed 

through 

# Processed: Number of records processed for the current 

cycle 

End of Cycle: Time remaining until the end of a cycle 

Last Update: Time the transmission was last updated 

To pause an active transmission job, click the “Now” option to pause now, or click 

the “At End” option to pause the job at the end of the cycle, and then click [Pause]. 

To stop the transmission, click [Stop Now]. 

Click [Resume] to restart the job. 

Clicking [Minimize] will minimize the Status window; the job will continue to run in 

the background. 

To close the Status window, click the [X] in the upper right hand corner of the 

window. 

Creating A Job 

A new transmission job cannot be created from scratch; it can only be created by 

copying an existing job and modifying it to suit the needs of the user.  

To create a new transmission job based on an existing job: 

Select an existing transmission job that is the same type (manual, automatic, crawl, 

web page, etc.) as what the new job should be. 

Click the [Configure] button for that job. 

Click [Copy Job]. When asked to confirm, click [Yes]. 

The Configure Job screen displays for the new job. 
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A new job name and ID number is automatically generated.  

Enter a new job name, if desired. 

To complete the job creation process, see the above section on configuring a job.  

Click [Save] when done and close the screen. The new job will display in the 

Transmission Status screen. 

 

Deleting a Job 

To delete a transmission job: 

From the Transmission Status screen, select the available transmission job to be 

deleted. 

Click the [Configure] button for that job. 

The Configure Job screen will display. 

Click [Delete Job] and confirm the deletion. 

Note: Only jobs which were created from an existing job can be deleted. 

 

 


